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Sapienza Moodle e-learning platform

* Goto

https://elearning.uniromal.it/enrol/index.php?id=13670

* Complete enrolment using Sapienza email account.


https://elearning.uniroma1.it/enrol/index.php?id=13670

MATLAB

* MATrix LABoratory -> MATLAB

 Commercial software produced by MathWorks Inc

http://www.mathworks.com/

e How to obtain it

* Since 2017: CAMPUS university-wide license available on InfoSapienza
website:

https://campus3.uniromal.it/campus/indexlogin.php

* You will need to setup an account at mathworks.com

 If you don’t have a Sapienza email account yet, you can download a 30 days
trial here:

https://it.mathworks.com/campaigns/products/trials.html



http://www.mathworks.com/
https://campus3.uniroma1.it/campus/indexlogin.php
https://it.mathworks.com/campaigns/products/trials.html

Matlab online courses

 Matlab On Ramp — short introduction course (2-4 hours)

 Matlab Fundamentals — more extensive course (10 hours)

* Goto

https://matlabacademy.mathworks.com/

And login with you Mathworks account connected to your
uniromal.it email address

e Suggested for both beginners and students who already used
Matlab


https://matlabacademy.mathworks.com/

Starting Matlab

You can start MATLAB by double-clicking on the MATLAB icon or invoking the
application from the Start menu of Windows (or the Applications menu under
Linux).

The main MATLAB window, called the MATLAB Desktop, typically looks as
follows:
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Typing commands

If you type a command at a command prompt, MATLAB executes the
command you typed in, then prints out the result. It then prints out another
command prompt and waits for you to enter another command.

In this way, you can interactively enter as many commands to MATLAB as you

want.

To exit MATLAB, simply click the mouse on the File menu of the MATLAB
command window and then select "Exit MATLAB" (or just enter quit at the
MATLAB command prompt).

Command Window

>> a = 5%4

20

©




Getting Help

There are three main functions that you can use to obtain help on a given
function: help, helpwin (short for help window, provides the same infoin a
pop up window) and doc (short for documentation).

Comman4 Window

Ji>> |

~Lhelp clc )
cl =ar command window.

clc clears the command window and homes the cursor.

See also home.

Documentation for clc

>> help date
tate ~rfent date as character vector.

S = date returns a character vector containing the date in dd-mmm-yyyy format.

See also now, clock, datenum.

Documentation for date

The doc command provides much more information, examples, etc.; it can
also be invoked by using the search box on the top right of the Matlab IDE



Creating variables (1/4)

Variables are a fundamental concept in MATLAB, and you will use them all the
time. Basically, a variable is a holding place for a value which you can give a
name to. The point of this is that, when calculating something new later, you
can use the value that a variable refers to as part of the new calculation.

You can define and use your own variables, their names will appear in the
workspace window together with the variables’ characteristics.

Note that the semicolon has the effect to evaluate the expressions without
printing out the results.

Command Window

»>




Creating variables (2/4)

If you don’t create a variable the value of the expression you type in the
command window is stored in a matlab default variable called ans (short for
"answer”). You can refer to that value by just typing ans:

Command Window

>> (7+3) *9

90

>>

ans is overwritten every time you issue a command, so it cannot be used for
long term storage...



Creating variables (3/4)

Typing clear at the command prompt will remove all variables and values that

were stored in the workspace up to that point.

o Note that, after the clear
. s doie ace command that removes all the
RS variables, the whos command
(;: e cannot find any variable name
< to display.

If you want to remove only some of the variables, just type the clear
mcommand followed by the names of the variables to be deleted

10



Creating variables (4/4)

There are some specific rules for what you can name your variables, so you
have to be careful.

o Only use primary alphabetic characters (i.e., "A-Z"), numbers, and the
underscore character (i.e., " ") in your variable names.

o You cannot have any spaces in your variable names, so, for example, using
"this is a variable" as a variable name is not allowed, but "this_is_a_variable"
is fine.

o MATLAB is case sensitive. What this means for variables is that the same
text, with different mixes of capital and small case letters, will not be the same
variables in MATLAB. For example, "A_VaRIAbLe", "a_variable",
"A_VARIABLE", and "A variablE" would all be considered distinct variables in
MATLAB.

o You can also assign pieces of text to variables, not just numbers. You do this
using single quotes (not double quotes --- single quotes and double quotes
have different uses in MATLAB) around the text you want to assign to a
variable.

o Be careful not to mix up variables that have text values with variables that
have numeric values in equations. If you do this, you will get some strange
results.



Vectors & Matrices (1/5)

Three fundamental concepts in MATLAB, and in linear algebra, are scalars,
vectors and matrices:

0 A scalar is simply just a fancy word for a number (a single value).

0 A vector is an ordered list of numbers (one-dimensional). In MATLAB they can be
represented as a row-vector or a column-vector.

0 A matrix is a rectangular array of numbers (multi-dimensional). In MATLAB, a two-
dimensional matrix is defined by its number of rows and columns.

In MATLAB, and in linear algebra, numeric objects can be categorized simply as
matrix: both scalars and vectors can be considered a special type of matrix.

For example a scalar is a matrix with a row and column dimension of one (1-by-1
matrix). And a vector is a one-dimensional matrix: one row and n-number of
columns, or n-number of rows and one column.




Vectors & Matrices (2/5)

In MATLAB matrices are defined inside a pair of square braces ([]). The blank

space and the semicolon (;) are used to divide elements in a row and different

rows, respectively

0 Note: you can also use a comma to divide elements in a row, and a carriage
return (the enter key) to divide rows.

Directly typed Matrix Row/Column Vectors Matrix by Vectors
.. >» ¥ = [1 23] ~ 5
»>»>Ah=[123;,456;7829)] >> Vet 1l = [4 5 8)”
- >> Vet 2 = [11 8 3]:
>> C = [Vet_1;Vet 2]
A= 1 2 3
> W = [1:;2:3 C =
7 > [ ]
4 5 6 v = 4 5 3
8 i 11 8 3
2
> 2 >
>> Note: You can create a Matrix also

merging two or more existent
matrices. 13




Vectors & Matrices (3/5)

More often than not, the type of data that you will work with will be vectors.
You can create them manually (as already explained) or by using the colon

operator, with the following syntax:

START_VALUE:INCREMENT:STOP_VALUE

Vector created using the Colon Operator

Command Window

>>» £ = 0:10:50

L =

>>

Example of negative increment

Command Window

>>» t = 50:-10:0
t =
50 40 30 20 10 0

>>

14



Vectors & Matrices (4/5)

Once a vector or a matrix is created you might need to extract only a subset of the

data, and this is done through indexing.

In a row vector the left most element has index 1.

In a column vector the top most element has index 1.

Indexing Vectors

Command Window

>> ¥ = [2 3 67]:

ans =

>> W = [3:10:4];

ans =

>>

Indexing Matrices

>> A
a =
1 2 3
4 5 6
7 8 9
>> A(2,3)
ans =
6
>>




Vectors & Matrices (5/5)

You can also extract any contiguous subset of a matrix, by referring to the row
range and column range you want.

For example, if mat is a matrix with 4 rows and 5 columns, then typing
mat(2:4,3:5) would extract all elements in rows 2 to 4 and in columns 3 to 5.

Matrix subset You can also modify any value in a
matrix or vector indicating is
5> C=[341256; 898 16943; 320076;7700 1] position and the new value to be

inserted
Cs=
3 4 12 5 6
8 98 16 9 43 Command Window
3 2 0 0 7
7 76 0 0 1 > C2(2,2) = 7;
>» C2
>> €2 = C(2:4,3:5)
C2 =
€2 =
16 23 16 9 43
6 0 7%
0 0 1 0 0 1
5> s




Element by element operations (1/2)

The element-by-element operators in MATLAB are as follows:

0 element-by-element multiplication: ".*"
element-by-element division: "./"
element-by-element addition: "+"

element-by-element subtraction: "-

Tyl s L AN
element-by-element exponentiation: ". el-by-el exponentiation

Command Window

. - . >> A = [2 2:0 2]
el-by-el multiplication (Hadamard product)
TR R A 2 2
>> V = [3 4 0]); 0 2
>> W= [2 9 10]; >> B = [1 2:3 4]
>> 2 = V.*W
B =
ue i 2
Z = 3 a
6 36 0 >> C = A.*B
C =
>> 2 4
0 16
>>




Element by element operations (2/2)

Element-by-element operators can be used with scalars and vectors together.
A few examples:

multiplication subtraction division
- Comrmand Window Cormrmand Window
Cormmand Windows
>>a=[3 5 6]
>» b = 2.%a B= s
] 10 12 & 10 12
b =
»>»> b -2 >> b./2
& 10 12 ans = i
- 4 8 10 3 5 6
> >»




Multiplication of 2 vectors/matrices

It is represented by the single symbol *
It carries out the well known matrix multiplication (rows by columns)

Vectors Matrices
Command Window Command Window
BN > A=[12 3:0410]:
>> b = [2 3 4]; >>B=[03;41;90]; & )
>> c =[S 7 8] >> C = A*B Note that the number of
>> d = bl rows in Ais the same as
C = the number of columns
in B.
d = ) - 35 5
Means “transposed 106 4
63 >3
CAVEAT:

A*B #A.*B



Visualizing data (1/7)

The basic plotting command in Matlab is plot,

When invoked with two same-sized vectors X and Y, plot creates a two-
dimensional line plot for each point in X and its corresponding pointin Y:

Jrgwera1 =loix|
Plot command Fie Ed ew Insert Todk Windon el
DBES RA2/ PAD
20
>>» X _axis = [1 2 3 4 5]; ..
>> y axis = [10 4 0 2 19]; or /
>» plot (x_axis, y_axis): 18y
> 14+
12+
BF
Matlab will display the figure in a 6t
pop-up window, if you decide to save 4
it the matlab default format is the 2
fig format 0 N
1 15 2 25 3 35 4 45 5




Visualizing data (2/7)

= If you want to label the axes, give your figure a title or create a grid in the
background of your plot, you can use the xlabel, ylabel, title and grid on command
respectively:

Plot labels and enhancement

= \
Command Window RI-TE]

Fls Edt “ew Insert Tools Window Help

>> plot (x_axis, y_axis); DSEHE NAA/ PAD
>> Xlabel('asse delle ascisse'):; grafic. d prove
>> ylabel({'asse delle ordinate'); = § : T ; P
>>» title('grafico di prova'):; - . T . """" .,l'#
>> grid on; = """"" “
ks I ) ' : Mt -
_-:> § 2 e s e e ¢ S
2 10 ]
- ISR (U S S S A _
o IR N N SR (S N Y 5 N !
| I U NS SRR SNUUORS SO 5 AN N J
I SN " W (S N B . i
s 3 25 5 35 & 5 s

asge delle ascisse




Visualizing data (3/7)

Let’s now plot a parabola introducing the x_axis significant points not one by
one, but using the shortcut already seen before:

Parabole plotting

T 7= na
> x axis = [-5: .1t §]; %vado da -5 a § con passo 0.1 DEEa A2/ 2RO
P>y = X_axis, 2; % pAbo liting
>» plot(x_axis, y); |
>» xlabel('asse delle ascisse'); 20l
>> ylabel{'valori parabola');
>» title('parabola plotting'); ol
: 2
g
Note that we have now
Inserted 100 x values in a 5l
very compact way
e T s e e

asse delle ascisse




Visualizing data (4/7)

Superimpose multiple plots in the same figure window allows to easily compare
the plots.

This can be done using the hold command.

Normally, when one types a plot command, any previous figure window is erased,
and replaced by the new plot.

If one types "hold on" at the command prompt, all line plots subsequently created
will be superimposed in the same figure window and axes.

"hold off" will revgrt to the default behavior

800 Figure 1
File Edit View Insert Tools Desktop Window Help
X A Command Window » NDEHSE Kh &aMms ¢ 0B o>
e :{_a:{is- . _—3 :0.5:3 13 - Cormparing bwo functions
> y=x_axis."2;
»> y2=x axis.*2; N NSO O S NE NE S d
>»> Pl=plot(x_axis,v¥); 5 5 5 5 5
>» get(Pl, 'Linewidth',3); Y I W R O NN SR S A
>> hold con
>> P2=plot(x axis,y2); L N .
>» get (P2, 'Linewidth',2, 'Color', 'red'): . é
>» title( 'Comparing two functions') F
> xlabel('x axis'); ; :
e }rlabl—_‘l[ Il" a}.iﬁl :IF S PP P RT R ;
»> grid on : : : :
s | -3 SN .............. S ................ ............... .............. .
-4 L.
& i
-3 2 1 1] 1 2 3
Xaxis




Visualizing data (5/7)

A different way to compare multiple plots is to have each of them in a separate
part of the window.

This can be obtained with the subplot command.

If one types subplot (M,N,P) at the command prompt, MATLAB will divide the
plot window into a set of rectangles organized in M rows and N columns

The result of the next "plot" command will appear in the Pth rectangle (where
the first rectangle is in the upper left):

[ roweno 1 =101 ]

Pl Edt Wew Insert Tools Window Help

DSE& AL~/ | BAD

Subplot ,

Command Window

>> subplot(2,1,1); plotix_axis, y):
>> subplot(2,1,2); plotix_axis, ¥2):’

>>

3 2 A 0 ] 2 3
i0 -
51 i




Visualizing data (6/7)

Two different kinds of three-dimensional plots can be displayed in MATLAB: 1)
three-dimensional line plots and 2) surface mesh plots:

three-dimensional line plots

00 Figure 1

= A File Edit View Insert Tools Desktop Window Help

>> x axis=[-3:0.1:3]; » DEEaE b Aa@me @ 08 =0

> y=X axis."3;

>> zE=pXp(=2.*(Y¥)).*sin(vy):
>» P3=plot3(x axis,y,z);
>> get(P3, 'Linewidth',3)

>> grid on |:>
=




Visualizing data (7/7)

surface mesh plots: You can use the mesh and meshgrid commands to create
surface mesh plots, which show the surface of three-dimensional functions:
How it works:

1) Generate a grid of points in the xy-plane using the meshgrid command.

2) Evaluate the three-dimensional function at these points.

3) Create the surface plot with the mesh command.

3-D Parabola PrTTYEE— D1
Fle Edt Yew Insart Took Window Hep
DSE& KA/ PPD

>> X_points
>> ¥_points
>>» [X, Y] = meshgrid(x_points,y points);
>>» 2 = X.*2 + Y.*2;

>> nesh(X,¥,2);

>> xlabel('x-axis'); ' \
>>» vylabel('y-axis'): £ 004

>> zlabel('z-axis'): L
| 0.

[-10 : 1 : 10]):
[-10 : 4 : 10];

>




Scripts (1/3)

A MATLAB script is an ASCII text file that contains a sequence of MATLAB
commands.

When naming a script file, one has to append the suffix ".m" to the filename, for
example "myscript.m". Scripts in MATLAB are also called "M-files”.

The commands contained in a script file can be run in the MATLAB command
window by typing the name of the file at the command prompt.

You can use any text editor, such as Microsoft Windows Notepad, or word
processor, such as Microsoft Word, to create scripts, but you must make sure
that you save scripts as simple text documents.

It is much easier to create your scripts using MATLAB's built-in text editor.

To start the MATLAB text editor simply type edit at the command prompt or
select File->New->M-file from the MATLAB desktop menu bar.

The MATLAB text editor provides syntax highlighting, making easier to read the
script, as well as the possibility of running and debugging the code



Scripts (2/3)

Example: the following script generating a parabola created using MATLAB's built-

in text editor. The name of the script is parabl.m:

Script edited using Matlab editor

If the script is saved in a

2 NN Editor - /Users/lucadn/Documents/Lavoro/Didattica/WirelessAccess/2010- ) ) ;

File Edit Text Cell Tools Debug Desktop Window Help directory included in the
- ,_.... Matlab path it can be

X A " 0 = = S & f. & £ I3 un by simply typing

¥ aw=[=5:.1:3];
y=x_ax. Z+1;

FL=plot(x ax,¥):

set (PL, 'Linewidth',3):
¥label('x axis'):;
ylabel('y axis'):
title( Parabola'):
grid on

O3 -] 2 L0 s el B =
| Y T B Y I

X Command Window

»>» parabl
== |

-

800

parabl at the Matlab
command prompt

Figure 1

File Edit View
e EE

30

Insert Tools Desktop Window Help

FReMe € 0E 50

Parabola




Scripts (3/3)

oComments in scripts help understanding the code
oA comment can be placed anywhere in a script with the % sign

File Edit Text Cell Tools Debug Desktor Window Help
» o D@ E &= ¢ 70OK

%$This is a comment

X ax=[-5:.1:5]; %And this is another comment|
¥=X_ax. 2+1;

PL=plot(x_ax,¥);

gset(PL, Linewidth',3):

xlabel('x axis'):

ylabel('y axis'):

title( Parabocla'):

grid on

=
1
&
3
4
5
6
7
8
9
0

1

'Ln 3 Col 45




Functions

Functions are M-files that can accept input arguments and return output
arguments. The names of the M-file and of the function should be the same.

Functions operate on variables within their own workspace, separate from the
workspace you access at the MATLAB command prompt.

Function squarebin Running squarebin
BT e

F'ﬂe Edit Yiew Text Debug GBreakpoints Web Window Help

DEH| & B0 | & HAF| AR

>> squarebin(l,3)

ans =

% calcola il ¢quadrato del binomio (a+b)

— =
function bin2 arebin (a,b) >

>> squarebin(l,8)

L S T e e

=| binZ2 = a*2 + b*2 + 2%a*h;

ans =

8l




Saving variables (1/2)

The save command can be used to save all or only some of your variables into a
MATLAB data file type called MAT-file. If you want to choose the name of the file
yourself, you can type “save” followed by the filename you want to use. MATLAB
will then save all currently defined variables in a file named with the name you
chose followed by the suffix ".mat"

Before saving you have to specify the path to where you want Matlab to save your
variables or simply change the current directory if you need to. To know which
directory is the current one just type the PWD command.

To see if your .mat file is where it should be you can use the dir command which
lists the file of the current directory.

If you want to save only a limited number of variables within your workspace just
type their names after the save command and the filename.



Saving variables (2/2)

= Saving steps:

> &

ans =

C: \MATLAE6pS\work

> attuale
>> @o)

attuale.nat generectz.asv squarebin.n

bandwidth_D.asv generect D.asv uwb

Rbup.fig binsource.asv nyfiles.mat
alohasin. asv csmasim. asv parabl.m

>>




Loading variables

Saved variables can be retrieved with the load command followed by a filename
(without the ".mat" suffix):

Command Window

>> clear % clear all the workspace variables

>tuale
>> whos
Name Size Bytes Class
3 & double array
34 char array
h & double array

Grand total is 19 elements using S0 bytes

>>




Adding a folder to the path

= To add a folder to the Matlab search-path simply select:

file>set path-> add folder->(select a folder)>save
=10l x|

All changes take effect immediataly.

MATLAD search path:
Agd Folder... l L CAMATLABGp Stwworkunwh :":I
3 CMATLABEpSUNatiabbrate2
(3 CAMATLABGpStoolboximatiabigeneral
LA CMATLABGpStoolboimatliablops
3 CAMATLABGpStoolboximatiabilang
3 CAMATLABGpSIHoolboximatiabielmat
LI CAMATLABGpSYociboximatiadeifun
LI CIMATLABGpStoolboximatiabispecfun
(3 CAMATLABGpSHoolboximatiabimatiun
L CAMATLABGpSTociboxdmatiab\datatun

L3 C\MATLABGpSHoolboximatiablaudio =
<] | 3

A3d with Subfolders.. |

Sava I Close | Rever: I Default I Help

or use theaddpath command followed by the complete folder path



If, then and elseif

The general form of the if statementis:

1f <expression>
<statement>,
<statement>, ..

elseif <expression>

<statement>,
<statement>, ..
else Example
<statement>,
<statement>, ..
a=3;
end
b=floor (5*rand(1,1));
if a>b

fprintf ('a=%d larger than b=%d/n',a,b);
elseif a==

fprintf ('a=%d equal to b=%d/n',a,b);
else

fprintf ('a=%d smaller than b=%d/n',a,b);

end




For and While

for <variable=expression>

<statement>, <statement>,.. end

N=5;

M=8;

for i=1:N while <expression> <statement>,
For §=1:M <statement>,.. end
A(1,3)=1/(i+3-1);
end b=0;

end a=10;

while (a>3)
b=b+1;
a=a-b;

end




Function “rand”

*rand uniformly distributed random numbers.

erand (N) is an N-by-N matrix with random entries, chosen from a uniform
distribution on the interval (0.0,1.0).

erand (M, N) is a M-by-N matrix with random entries on the same interval.

octave-3.2.3:8> V=rand (3)
V:

0.885006 0.985149 0.193368
0.060968 0.912635 0.719775
0.894609 0.040091 0.480421

octave-3.2.3:9> W=rand (1, 3)
W:

0.50589 0.70535 0.15719




Function “zeros”

*ZEIrOsS Zeros array.
ezeros (N) is an N-by-N matrix of zeros.
ezeros (M, N) is an M-by-N matrix of zeros.

octave-3.2.3:8> V=zeros (4)
Vv =

O O O o
O o O o
o O O o
o o O o

octave-3.2.3:9> W=zeros (1, 3)




Function “ones”

eones Ones array.
eones (N) is an N-by-N matrix of ones
sones (M, N) is an M-by-N matrix of ones.

octave-3.2.3:8> V=ones (4)
V:

e
e
B e
e e

octave-3.2.3:9> W=ones (1, 3)




Function “find”

find Finds indices of nonzero elements.

T = find (X) returns the indices of the vector X that are non-
zero.

Note that X can be the result of the evaluation of an expression
Example:

octave-3.2.3:17> A=floor (200*rand(1,10))
A:
83 142 81 69 119 3 36 87 10

octave-3.2.3:18> X=A>100
X:
0 1 0 0 1 0 0 0 0 0

octave-3.2.3:19> I=find (X)
I:

octave-3.2.3:20>

88



LE 11

Function “length”, “max” e “min”

length: Length of vector.
*For a vector, length (X) returns the number of elements in X.
*For a matrix NxM, length (X) returns the largest dimension between N and M.

max: Largest component.
*For a vector, max (X) returns the largest element in X.

*For a matrix, max (X) returns a row vector containing the largest element of each
columnin X.

min: Smallest component.
*For a vector, min (X) returns the smallest element in X.

*For a matrix, min (X) returns a row vector containing the smallest element of each
column in X.



Function “sort” (1/2)

sort: sorts the elements of a vector in ascending or descending order
*For a vector, sort (X) sorts the elements of X in ascending order.
*For a matrix, sort (X) sorts the elements of each column of X in ascending order.

>> V=[7 5 9 2 4];
>> sort (V) >> A=[7 5 2; 4 3 5; 9 8 3]
ans = A =
2 4 5 7 9 7 2
4
>> 9

>> sort (A)

ans =
4 2
7 3
9 8 5

>>




Function “sort” (2/2)

The default behavior of sort can be modified with additional inputs
*sort (A,dim) sorts the elements of a matrix A in ascending order by dimension

dim (dim=1: columns (default), dim=2: rows).

esort (A, 'descend’ ) sorts each column of a matrix A in descending order
sort (A, 2, ' descend’ ) sorts each row of a matrix A in descending order

>> A=[0 23 12;
A:
23 12
5 3 6
>> sort (A, 2)
ans =
0 12 23
3 5
>>

5 3 6]

>> A=[0 23 12; 5 3 0]

23 12
5 3 6

>> sort(A,2,’'descend’)

ans =

>>




Function “round”, “ceil”’ e “floor”

*round: Round towards nearest integer.
*floor: Round towards the integer immediately lower.

*ceil: Round towards plus the integer immediately higher.

octave-3.2.3:30> test= [0.4 0.7]
test =

0.40000 0.70000

octave—-3.2.3:31> round(test)
ans =

octave-3.2.3:32> floor (test)
ans =

octave-3.2.3:33> ceil (test)
ans =

octave-3.2.3:34>




Function “size”

size: Size of each dimension of a vector/matrix

*For vectors, same as length
*For matrices, different behavior

>> A=[7 5 2; 4 3 5;]

>> length (A)
ans =
3

>> size(A,1)
ans =
2




Function “sum”

sum: Sum of elements of a vector/matrix
*For vectors, it returns the sum of all elements

*For matrices, it returns a row vector
containing the sums of the elements of each

row

*Behavior for matrices can be changed as seen

for the sort command

V:

1 2
>> sum (V)
ans =

6

A =

1 2

2 4
>> sum (A)
ans =

3 6

>> sum (A, 1)
ans =

3 6

>> sum (A, 2)
ans =
6
12




Function “bar”

bar: Bar graph
*Typically used when the values are not samples of a function

>>
>>
>>
>>
>>
>>

V=[8 9 10 6 4 3];

bar (V)

title('Bar graph title')
xlabel ('Categories")
ylabel ('Values')
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